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Quick Start
About Quick Start
The goal of Quick Start is to provide additional material that will help customers quickly
get started using Wealth-Lab Pro. For more in depth detail on any of the topics covered
refer to the specific topics in the Wealth-Lab User Guide, WealthScript Language Guide,
or QuickRef (F11), all located within the Help menu of Wealth-Lab Pro, or on Fidelity.Com
’s Active Trader download section.

Important Note: Examples of specific securities or concepts depicted in the in this Wealth-Lab
Pro Quick Start and User Guides are given for illustrative purposes only and should not be
used or construed as a recommendation or offer for any specific security.

Fidelity’s Wealth-Lab Pro is available to those investors in households that place 120 or more stock, bond, or
options trades in a rolling twelve-month period, plus $25,000 in assets across their eligible Fidelity brokerage
accounts are eligible for Wealth-Lab Pro. Combined household trading activity is calculated each business day.
Customers who do not maintain the required trading activity in their combined household accounts will become
ineligible for Active Trader Pro and Wealth-Lab Pro entitlements without notice. See the Household
Relationship Form for details on how to authorize Fidelity to consolidate accounts held by you, or your
immediate family members who reside with you, into an aggregated relationship household.
Fidelity Brokerage Services, Member NYSE, SIPC
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How to gain access to Wealth-Lab Pro
Wealth-Lab Pro is available to customers wishing to access the software in a limited 30
day trial or a fully integrated version. Note the full version of Wealth-Lab Pro is only
available to qualified Fidelity Active Trader customers.
30 Day Trial Version
A Wealth-Lab Pro 30 day trial version is available with limited functionality to all current
and potential customers interested in sampling the software’s capabilities. To access the
trial version go to Fidelity.Com/Investment Products/Active Trader/Download, or call
1-800-TRADER1 for more information.
Full Wealth-Lab Pro Version:
The fully integrated version of Wealth-Lab Pro offers all the product’s functionality to
develop and back-test trading systems, and place trades based on your technical trading
strategies. This version is available to Investors in households that place 120
commissionable stock, bond, or option trades in a rolling 12-month period, plus $25,000
in assets across all their eligible Fidelity brokerage accounts. Call 1-800-TRADER1 for
more information. Eligibility for the fully integrated version of Wealth-Lab Pro is subject
to change by Fidelity.
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New and Noteworthy
Wealth-Lab Pro Version 5.1 includes a number of features and enhancements designed to
help you build, backtest and trade efficiently. Place trades, view account information,
define Workspaces and manage stock symbols/data with ease.

1.2.1

What's Changed
Trading
· Trading has been implemented throughout the application and is independent of
Active Trader Pro®.
· Turn your Alerts into trades for the Strategy Monitor, Quotes, and Strategy Window.
· Use the Orders tool to view and manage your trades.
Special note for Version 4 customers: PortfolioSynch has not yet been
implemented in Version 5.
Warning!
Do not use the same Windows User login to trade accounts for more than
one Social Security Number (SSN). If necessary, create a separate
Windows login for each SSN, and run Wealth-Lab Pro in a separate
Windows session for each user.
Manual Trade Ticket
Place a manual trade any time with the new Trade Ticket. Use the Ctrl+T shortcut to
display and hide the trade ticket for discretionary trading. See Manual Trading in the
Orders tool topic.
Trading Preferences
A new Trading preference group is available to control certain aspects of automated
trading with Fidelity. See Trading Preferences.
Don't miss the preferences in Advanced Options for determining Orders tool
behavior when Staging or Placing orders.
Accounts Tool
· Access your account's current equity holdings in the Positions view. The Positions
view will reflect up-to-date open Positions (and their actual gain/loss) held in your
Fidelity account.
· View your Available Cash, Buying Power, Positions Value and Positions Profit/Loss.
· The Local Trade History shows trades placed using Wealth-Lab Pro on your
computer for each account.

© 2008 FMR LLC All rights reserved.
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For the numerous details, review the topics in the Orders and Accounts tools chapters.

1.2.2

What's New
General
Dynamic Home Page functionality
The What's New section will update dynamically to display links to Help, information
about new features in Wealth-Lab Pro, links to the Wealth-Lab Community, and
Expert Strategies. If you're not connected, the last page saved is shown.
Pre-configured Workspaces
Two pre-configured Workspaces are selectable using Workspaces > Open Workspace
(Ctrl+W). See: Workspaces
Mouseovers for the Equity Curve
Hovering the mouse pointer over a curve will display its date and precise dollar value.
See: Equity Curve
References to .NET assemblies
Power users can select references from a static list of .NET assemblies for use in
strategy code. See: Editor
Charting
Point and Figure Chart Style
Along with the option-packed Point and Figure (PnF) Chart Style, Wealth-Lab Pro
boasts a backtesting capability for PnF methodologies, unique among retail technical
analysis applications. Look for the Point and Figure Basic Strategy included with this
installation. See Point and Figure for more details.
Streaming Heartbeat
Version 5's initial release required that a tick print in the next interval in order to
determine the end of the previous interval for streaming charts. Although the same
logic is utilized to expeditiously end intraday intervals for fast-trading stocks, bar
intervals for even slow-trading instruments will end within a few seconds of their
predetermined time whether or not a tick occurs in the subsequent interval. See
Streaming Charts.
Right Click Trading
Quickly stage/place discretionary market orders for the charted symbol by
right-clicking its chart and selecting Buy, Sell, Short, or Cover from the context
menu. See Right Click Trading.
Data and Symbol Management
Fidelity Symbol Management in the Data Manager
Detect, remove, or change "old" symbols, and relocate your Fidelity data in the path
of your choice. See Symbol Management.
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Strategy Builder
Parameter Sliders for the Strategy Builder
Use the convenient sliders for changing parametric values for Strategy testing and
trading for Strategy Builder rules. See Parameter Sliders for the Strategy Builder.
Rules Added:
· MACD Histogram crosses above/below a Value
· Price is above/below a Value (backtest)
Printing/Copy to Clipboard
Print and Copy
Just about wherever tables, charts, and data are displayed, right-click menu items
allow you to copy the data to the Windows clipboard for pasting into other
applications. Printing is also available throughout the application. See Printing
Preferences in Advanced Options.
Strategy Monitor, Strategy Explorer
Associate Strategies with Accounts
If you have only one Fidelity account, no action is necessary on your part to specify a
default account or to associate Strategies with an account.
For customers with multiple accounts, you should specify the destination account(s)
for trading actions produced by discretionary and automated Strategy trading. Please
follow these steps now to configure Wealth-Lab Pro:
1. Launch Wealth-Lab Pro and Log in to Fidelity.
2. Open Trading Preferences (F12) and choose your preferred Default Account for
trading actions.
3. For Strategies that you trade (or plan to trade), specify their default account
association using the new Set Account action in the Strategy Explorer.
4. Finally, you can specify the account to associate with Strategies added to the
Strategy Monitor in the Activation Settings dialog. See Strategy Monitor.
If you do not associate an accounts, then the Default Account preference is
used.
Indicator Corrections
Corrections were applied to the following Standard indicators:
· AveragePrice
· AveragePriceC
· KeltnerUpper, KeltnerLower
· StochD
· CCI
· FAMA
· LinearRegSlope
· FIRSeries
· MomentumPct (MomentumPctSeries was not affected)
· VHF
© 2008 FMR LLC All rights reserved.
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Strategy Revisions
The Version 5.1 installation includes an update to the Head and Shoulders Top, Darvas
Box, and Bandwagon Trade strategies. If you upgraded to 5.1 from 5.0, to update the
code, open it and replace the Strategy code with that below, and save it. The code is
available in the on-line CHM version (F1) of this Help document .

© 2008 FMR LLC All rights reserved.
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Entitlement
Wealth-Lab Pro Version 5 requires an entitlement to run the software with full
functionality. The following steps detail the process. Please note that entitlements will
be given to qualified Fidelity Active Trader Services customers. All others should call
1-800-TRADER1 for further information.
The 30 day Trial version does not require an entitlement and can be used with
limited functionality once your download is complete.
Follow these easy steps to start using Wealth-Lab Pro:
Step 1:

Download the 30-day trial version software from Fidelity.com/Investment
Products/Active Trader/Download.

Step 2:

Open or save the download to your computer.

Step 3:

Run the installation.

Step 4:

Accept the user agreement to complete the installation.

Step 5:

For users who don’t have an account with Fidelity Active Trader Pro and are
downloading the 30 day trial version you can now begin using Wealth-Lab
Pro.
The 30 day Trial version does not require an entitlement and can be used
with limited functionality for 30 days.

- Or Step 6:

1.3.1

If you are eligible for Wealth-Lab Pro and have already been granted
access, you may now begin to use the full version of the application. You
are no longer required to obtain an entitlement key from Fidelity.

Home Page
Navigate through Wealth-Lab Pro quickly and easily by using the Home page. Access the
key features and tools you need to build, backtest, monitor, and trade your Strategies
right at your finger tips.

© 2008 FMR LLC All rights reserved.
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Figure 1.1 Wealth-Lab Pro Home Page

Key Sections
1) View Charts View historical or real-time charts for your favorite stock. Enhance
your analysis with drag & drop technical indicators and fundamental
data or use the drawing tools to create support and resistance
channels, tradable trendlines or chart annotations.
2) Explore and Explore pre-built trading strategies for ideas, or customize them to
Backtest
validate your own trading ideas by backtesting the idea and analyzing
the hypothetical results.
3) Build and
Backtest

Build your own trading strategy easily with drag & drop functionality,
or program your own strategy. By backtesting your trading strategy
using historical data you can see the hypothetical performance of
your strategy and understand how your strategy could behave in the
future.

4) Activate
Strategies

Now that you've built a strategy, add that strategy to the Strategy
Monitor. Monitor your trading strategies for trade alerts in one
location. Customize each strategy to your trading preferences with
backtesting parameters like scale, trade size or portfolio management
settings, data range, and symbols. Activate each strategy to
automatically check for data updates and new trade alerts, and then
manage those alerts from the same window.

5) Manage
Orders

With the Orders tool get the latest status on active, canceled and
executed orders thru Wealth-Lab Pro.

6) What’s New This section will update dynamically to display links to Help,
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Quick Start

9

information about new features in Wealth-Lab Pro, links to the
Wealth-Lab Community, and Expert Strategies. If you're not
connected, the last page saved is shown.
7) Recently
Viewed
Strategies

1.3.2

Track recently viewed strategies and easily go back to review
hypothetical performance, change parameter settings, and re-run the
backtest using the changed values. Analyze the effect of the changes
in the hypothetical results.

Charting Basics
Opening up a basic Chart
Now that you have installed Wealth-Lab Pro, one of the basic functions is to view a chart,
but before doing that you will need to collect the stock’s data. You have two options as to
which data you wish to display. The first option would be to connect to a data provider
of your choice. Eligible customers with the full version of Wealth-Lab Pro have the option
to access live streaming data through Fidelity or downloading static historic data without
any additional costs.
In the previous version of Wealth-Lab Pro, Active Trader Pro® had to be
running to receive data from the Fidelity live feed. Logging in to ATP is no
longer required. You can log in to Fidelity directly from Wealth-Lab Pro by
clicking the Log in to Fidelity button located on the Function toolbar or by
selecting the Fidelity Account Log in option in the File menu.

Enable Streaming Feed
To enable streaming data in a Chart or Strategy window, select the Scale and Data
Range fields to check your settings. Then click on the Streaming button in the bottom
right hand corner to enable streaming as indicated in Figure 2.0.

© 2008 FMR LLC All rights reserved.
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Figure 2.0 Selecting Scale, Data Range, and Streaming.

Steps to view a basic Wealth-Lab Pro chart
1)
2)
3)
4)
5)
6)

Log in to Fidelity via the Function toolbar.
Open a Chart or Strategy window.
Verify the Scale and Data Range settings are correct.
Click the Streaming button in the lower right hand corner of the charts.
Type in the symbol of your choice in the Symbol entry box.
Click the Go button.
Basic charts can also be viewed using static historical data stored in
Wealth-Lab Pro. See the Manage Data 11 section to learn how to download
static data.

© 2008 FMR LLC All rights reserved.
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Manage Data
Collecting Static Data
Static data is historical data that you've previously collected on your computer consisting
of different time intervals daily, or 1, 5, or 10 minute data, for example, that is used for
analysis and backtesting. This is a critical step in using Wealth-Lab Pro since market
data powers all your tools.
Failing to do this in advance will result in a “No Data Available” Message when
attempting to view a chart. If the On Demand Data feature is active the chart
data will be downloaded and displayed. There is a delay while the data is
being downloaded. Symbols with intraday timeframes such as 1, 5 and 10
minutes may experience significant delays due to the amount of data being
downloaded.

Create Datasets that capture your market data
The Data Manager is the component of Wealth-Lab Pro that manages the data you need
to build and test your trading strategies or to review a historic chart. It provides a
number of functions that let you manage, edit, and update your data. It also contains
special features for managing Fidelity and other Integrated Data Providers. You can
access the Data Manager by selecting it the main toolbar (Fig. 3.0) or by using the
keyboard shortcut Ctrl+M.

Figure 3.0 Launch the Data Manager from the Navigation toolbar.

Data Manager
Once in the Data Manager you have two main actions:
1. Create a new DataSet.
2. Modify or update an existing DataSet like the Dow 30.
See the User Guide's Data Manager topic for more details and other data maintenance
options.

© 2008 FMR LLC All rights reserved.
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Figure 3.1 Data Manager showing Symbol Details for the selected
DataSet (Dow 30) and right-click DataSet actions menu.

Creating a New DataSet Using The Wizard
To create your own symbol list, select the DataSet Wizard and start entering the symbols
that you would like to collect, separated by commas or spaces. You can also import a list
of symbols from Industry Data. After defining the symbol list choose among data bar
frequencies of daily, or 1, 5, 10, 15, 30, and 60 minutes in the lower dropdown menu
and click the next button to complete creation of the DataSet symbols (Fig. 3.2). To
collect data, follow Update instructions.

Figure 3.2 New DataSet Wizard

© 2008 FMR LLC All rights reserved.
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Manual or Automated Data Updates
Wealth-Lab Pro Version 5 allows you to perform manual data updates or Schedule Data
Updates in the same interface - the Data Updates tab in Data Manager. To conduct a
manual data update, select from historical data providers Fidelity, MSN, and/or Yahoo!
Next, select the fundamental data providers you wish to update. Now, select the Update
all data for selected Providers now button, which will update all your stock end of day
and intraday price data, and selected Fundamental and Economic Indicator data (Figure
3.3).
Downloading intraday histories for the first time can take several minutes per
symbol.

Figure 3.4 Data Manager running a manual data update

Another way to keep your data current is to enable Automated Data Updates (Fig. 3.4).
It is highly recommended that you keep your market data as up to date as possible by
running daily manual or scheduled data updates to maximize your experience with
Wealth-Lab Pro.
Your PC must be on and Wealth-Lab running during the hour that you've
scheduled automated data updates.

© 2008 FMR LLC All rights reserved.
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Configuring Options
Use the Preferences tool to control and personalize the default settings in Wealth-Lab Pro
. Some of the settings can be overridden from within a Strategy using corresponding
WealthScript functions. Choose from: Chart Color/Style, Chart Annotations, Streaming
Data, Performance Visualizers, Commissions, Backtest Settings, Slippage and Round
Lots, Sounds, and Advanced Options to create the setting for you. All these settings may
be found by selecting
Preferences, or using the F12 shortcut. This is the first step in
personalizing Wealth-Lab Pro.

Figure 4.0 – Wealth-Lab Pro Preferences

Chart Layout
Use the Chart and Scale toolbars to control the appearance of the Chart View. Configure
the default settings for Chart Color, Fonts, and Grid Lines using the Colors/Style view of
the Preferences tool. Use the Chart Drawing Toolbar (far right) to apply Fibonacci Lines
or a Regression Channel (Fig. 4.1).

© 2008 FMR LLC All rights reserved.
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Figure 4.1 – Chart Layout controls.

Chart Toolbar
Use the Chart toolbar to customize the appearance of your charts by increasing or
decreasing bar spacing, or change the chart style to Kagi or Renko among the many
other options offered (Fig. 4.1).
A DataSet represents a link to a source of static historical market data. DataSets appear
in a tree view along the left side of the application in the Data Panel, which can be
viewed or hidden from the View menu or using the Ctrl+D shortcut. Contained in each
branch of the tree are the symbols that make up the DataSet.

© 2008 FMR LLC All rights reserved.
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Using Strategies
What is a Strategy?
In general, a Strategy is your trading system that is normally used to automate methods
and features within Wealth-Lab Pro. A Strategy is a script, a small computer program,
written using WealthScript functions in a supported Microsoft .NET language. Strategies
contain the trading rules you use to trigger trade alerts, but also usually contain
instructions for plotting indicators and various other annotations on charts.
Consequently, a Strategy packages the trading system logic with its visual presentation.
Strategies can be written in a programming language, but can also be created by using
Drag and Drop Rules, making it easy for non-programmers to craft trading strategies
visually.

Included Strategies
Wealth-Lab Pro Version 5 comes with approximately 25 pre-built strategies, a list of
standard technical indicators, and a list of fundamental data items that you can leverage
to help create your own trading systems.

1.6.1

Design your Trading Strategy
Strategy Builder
Wealth-Lab Pro has the most advanced and capable Wizard available to help you design
and produce complete trading systems without the need for you to manually write any
code! The Strategy Builder allows you to visually design a trading system by combining
various types of Entries, Exits, and Conditions via an easy-to-use drag-and-drop
interface. Even if you like to write your own code, the Strategy Builder can give you a
head start in rapidly prototyping new trading systems.
The Strategy Builder utilizes a database of Entries, Exits, and Conditions, which are
collectively referred to as Rules. The Wealth-Lab Pro installation comes with a full set of
Rules (Fig. 6.0).

© 2008 FMR LLC All rights reserved.
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Figure 6.0 – Strategy Builder

How to use the Strategy Builder
The following steps outline a suggested procedure for using the Strategy Builder. The
order in which you add, delete, or modify rules is not important.
Step 1. Activate the Strategy Builder.
Select Charts and Strategies > New Strategy from Rules. The Strategy Builder dialog shown
above appears along with a new Strategy window (Untitled) in the background to which
the Wizard will ultimately apply the chosen rules.
Step 2. Elect your Position Management options.
Single Open Position at a Time:

Choosing this option will result in a script that
manages only a single open position in a given
security at any given time. You may select "Allow
Stop and Reverse on Same Bar" with a single position.

Multiple Open Positions:

Elect this option to allow your script to manage more
than one open position in a given security
simultaneously.

Step 3. Form your basic strategy by selecting Entry and Exit types.
Drag and drop an Entry or Exit type to the window on the right. You can also double
click an Entry or Exit to select it, which is then added to the bottom of the list. An Exit is
paired with the Entry directly above it. The Wizard accomplishes this by assigning a
unique Position Signal Name to each Entry selected, as you can later verify in Strategies
with multiple Entry and Exit strategies. Placing an Exit at the top of the list (above any
Entries) applies it to all Entries of the same type in the strategy. For example, you may

© 2008 FMR LLC All rights reserved.
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wish to place a Trailing Stop at the top of a list so that it will be used against all Long
Entries, as shown above.
Many of the Entry/Exit items have a description, which is displayed in a text
box underneath the selections. Highlight an Entry/Exit by clicking on it and the
description containing information about the item is displayed.
Step 4. Assign Conditional Rules to your Entries and Exits.
Click the Conditions tab to begin assigning conditional Rules to your selected Entries and
Exits as shown in the image below. Qualify Conditions by dropping them on top of a
selected Entry or Exit. Multiple Conditions added to the same Entry or Exit are “AND”ed
together, but will be accessed in the order entered. To “OR” Conditions, separate them
with the OR Divider by dropping it on top of the second (lower) Condition in an Ordered
pair.
Step 5.
Run the Strategy.
You may go back and forth, altering Entries, Exits, and Conditions, and refining
parameters. When satisfied, click the Run Strategy Now button to execute your
Strategy. If you want to see how the Wizard turns your work into WealthScript code,
click on the View Strategy Code button. Notice that the Wizard automatically adds the
necessary code for plotting any indicator that you have selected for trading conditions in
the Strategy.
A Rules tab instead of an Editor tab in the Strategy window indicates that the Wizard has
complete control of the Strategy code. If you selectConvert to Code-based Strategy
you can no longer use the Strategy Builder to modify the Strategy.
Step 6. Save your work!
If you wish to continue working with the Wizard at a later time, save your Strategy and
Wealth-Lab Pro will remember that the script is under the Strategy Builder's control. The
next time you open the strategy, you may re-visit the Wizard by clicking the Rules tab in
the Strategy window.

1.6.2

Build a Strategy from Scratch
For more sophisticated systems programmers, you can build you own Strategies from
scratch by creating your own code and ideas. Simply open a New Strategy from Code
from the main menu toolbar by selecting Charts and Strategies > New Strategy from Rules.
This will open a Strategy window template. Select the Editor view, which gives you
open access to the WealthScript code needed to program your own Strategies (Fig. 6.1).

© 2008 FMR LLC All rights reserved.
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Figure 6.1 Developing and Editing a System

Template Code
A "New Strategy from Code" window always initializes the Editor view with a "skeleton"
(template) to start working from. If you frequently use the same library references
and/or variables in Strategies, you can save yourself time by editing the Template and
then selecting Edit > Set as Default Template Code.
Editor Options
Set your preferences for how the editor displays text, fonts, functions and other items
from the Editor's Options dialog, selected right from the Editor's toolbar.

© 2008 FMR LLC All rights reserved.
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Backtesting Trading Strategies
Running your Strategy
Once you've built a new Strategy you can use it to Backtest by:
·
·

Choosing the Scale (interval), Data Range (timeframe), and Position Size (money
management rules) you would like to analyze (Fig. 7.0).
Choose a security to backtest against from your DataSets or enter a symbol and click
the

button to run the Strategy.

Figure 7.0 – Running your Strategy

Multi-Symbol Backtesting
You develop and backtest trading systems on individual securities in the Strategy
Window. You can now easily test a system’s performance on a list of stocks or DataSet
without going to a new tool with Multi-Symbol or Portfolio backtesting.
To run a Portfolio backest from the Strategy window:
·
·
·

Click on the desired DataSet (Fig. 7.1).
Make sure your settings for Scale, Data Range and Position Size are correct.
Click the Backtest on all Symbols button.

How the Multi-Symbol Backtest Works:
Wealth-Lab Pro executes the selected Strategy on each of the symbols in the selected
DataSet. This is done in a raw profit mode to compile all of the possible trades into a

© 2008 FMR LLC All rights reserved.
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single collection. It then aligns the trades by date and time, applies position sizing rules,
and finally reports on the overall system results, which includes a portfolio equity curve
based on the starting equity that you specify before running the backtest.

Position Size Settings
Applying your personal position sizing rules
(share or dollar) mirroring the way you
invest is a key component to properly
simulating how your trading strategy may
work under market conditions.
Wealth-Lab Strategies are Position-based.
You don't have to worry about the actual
size of Position in your Rules or code.
Wealth-Lab will apply the sizing method
that you select from the Position Size
control atop the Data Panel (Fig. 7.1).

Figure 7.1 Position Size Control
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Monitoring Strategies
Strategy Monitor
Now that you have built and backtested one or more Strategies, run them regularly to be
alerted of potential trading opportunities. The Strategy Monitor allows you to track one
or several Strategies at the same time. Each Strategy can have its own custom
parameters, time frames, data range, and position sizing to monitor for current trade
signals (also known as Alerts) for each activated Strategy. To access the tool (Fig. 8.0),
select Strategy Monitor from the Function toolbar or strike the F3 shortcut.

Figure 8.0 Strategy Monitor

Adding a Strategy
From the Strategy Monitor itself, just select
Add A Strategy, which launches the Strategy
Explorer. Navigate to the Strategy you want to add and click OK. Alternatively, from
the bottom left of a Strategy window you can click the Add to Strategy Monitor link.

1.8.1

Configuring Strategies
Choose your settings
After adding a Strategy, the Strategy
Activation Settings page is displayed
(Figure 8.1). These settings allow you to
customize each Strategy to your liking.
The settings in the Data Panel
do not control the settings in
the Strategy Monitor.
Choose from scale, data range, position
size, Strategy parameters, and the
symbol or DataSet you would like to test
against. Once configured and activated
23 , the Strategy will be executed
against these parameters until you
change them.

Figure 8.1 Strategy Activation Settings page
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Choosing "All Data" in the Data Range setting for intraday Strategies will
result in reduced performance due to the large amount of data being
processed. Since you are looking for Trade Alerts based on the most recent
price action we recommend choosing a smaller amount of data for this setting.

Changing Settings
To change your settings, highlight a Strategy and select the
Change Settings button.
Alternatively you can double click the Strategy. Either action launches the Strategy
Activation Settings page for a new settings configuration. If you save new settings by
clicking OK, the Strategy must be reactivated.

1.8.2

Activate Strategy
Activate the Strategy
Strategies must be Activated to process data and generate Trading Alerts. To Activate a
Strategy, highlight it and click on the
Activate Strategy button. The Strategy
Monitor automatically updates the data for each symbol at the appropriate interval
selected whether daily, weekly or monthly or intraday as long as Wealth-Lab Pro and the
Strategy Monitor are running. You will know the strategy is active by the
yellow icon
appearing next to the Strategy. The Strategy will now be run at the next interval
displayed. After the data is updated, the Strategy is re-executed and any Trade Alerts
are displayed in the bottom of the window (see figure 8.2). The Last Run and Next Run
fields display the time and date of the most recent and next data updates.
If you have Strategies that are run on a periodic basis you can still add them to the
Strategy Monitor for quick access when you want to use them. To run the Strategy,
simply Activate the Strategy or select Run this Strategy now item in the right click menu.

Managing Trade Alerts
In the previous version of Wealth-Lab Pro, users ran WatchList Scans or Real-Time Scans
to receive current Trade Alerts. The functionality of these tools is now combined in the
Strategy Monitor. Trade Alerts are displayed in the Alerts section of the Strategy Monitor
window (see figure 8.2). Alerts can be displayed by Strategy or as a group.

Figure 8.2 Strategy Monitor Alert Pane
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When an Alert is received for a strategy, the Alert can be sent to the Quotes tool for
further monitoring or to the Orders tool for trading. You can configure Strategies to
automatically send the Trade Alerts to the Orders tool by enabling
Auto-Stage button.
Live trading is not enabled in the current Wealth-Lab Pro 5.0 release.
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Trading Your Strategy
Now that you have honed your strategy and determined the parameters, position sizing
and money management rules you are comfortable with, you are ready to trade. To
place trades in Wealth-Lab Pro you must be logged in to Fidelity. Click on the Log in to
Fidelity button in the Function Toolbar or the Log in button on the Manual Trade Ticket (
Ctrl+T). If this task is not completed prior to launching the Orders tool or placing a
manual trade, you will be prompted to log in.

1.9.1

Orders Tool
Wealth-Lab Pro provides a bridge from back-testing to fully-automated real-time trading.
The Orders tool acts as a central point in a complex integration environment. It receives
information in the form of Alerts from various Wealth-Lab tools and opens a 2-way
communication channel with Fidelity. In addition, it logs trade status, trade messages,
and updates Positions and Local History in the Accounts tool.
Open the Orders tool by clicking on the Orders selection in the toolbar, selecting it from
the Tools menu, or by using the keyboard shortcut Ctrl+R. If you have not already
logged in to Fidelity, you will be prompted to login before the tool is launched. Once you
are logged in you are ready to trade.
Additionally, the Orders tool automatically opens whenever another tool sends an Alert
for order processing. Order(s) will be queued until you submit the Staged order(s).
If you do not want the Orders tool to open each time an Alert is sent you may
turn off this capability in the Preferences menu.
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Figure 9.0 Manual Trade Ticket (top) and Orders tool

1.9.2

Trading Basics
Set a default account
If you have more than one Fidelity
account, choose which account you
would like to place trade in.
Choose the default account from
the list displayed in the Trading
preferences menu.

Enter a manual trade
Wealth-Lab Pro 5 includes an order
ticket for you to place manual
trades quickly. The trade ticket is
visible regardless of which tool is
being used, and can be configured
to appear at the top or bottom of
the application. Quote data has
also been added to the ticket for

Figure 9.1 Default Account Preference
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your convenience. A variety of
options are available to you from
the Wealth-Lab Pro Trade Ticket.
Actions: Buy, Sell, Short and
Cover, Order Type: Market,
Limit, Stop, TIF: Day and GTC.
Order Routing: AUTO – Fidelity’s
proprietary order routing, and,
QWIK – RapidRouter™ Fidelity’s
intelligent order router.

Figure 9.2 Manual Trade Ticket

Strategy-Generated Trades
Backtesting a Strategy allows you to generate trade alerts for a single security or an
entire list of securities. The Strategy runs against historic or intraday data to generate
trading signals, or Alerts, and also provides a detailed report of trading system
performance.
When you backtest a stock, any alerts generated appear in the Alerts tab of the Strategy
window. If you are using daily data in your test, options to manage Alerts include the
Place Orders, Stage Orders, and Monitor in Quotes window buttons. Place Orders
immediately sends the orders to the marketplace. Stage Orders sends the orders to the
Orders Tool. Staged orders are queued until you take further action.
If your strategy generates a large number of Alerts, you may choose to send some or all
of the Alerts to be monitored in the Quotes tool. This feature allows you to watch your
alerts in real-time and set a threshold at which the Alert is turned into a trade.
Alerts generated using streaming data also have the ability to be Auto Staged or Auto
Placed (if Auto Trading is enabled). Auto Stage allows users to send the order
automatically to the Orders tool for further action. Auto Place sends the orders to the
marketplace.

Strategy Monitor
With the Strategy Monitor, there's no need to open and run multiple strategies that you
want to trade. Add and activate multiple Strategies in the Strategy Monitor and you are
ready to begin. Whether you are using a daily or intraday interval, each strategy will be
evaluated for new trading opportunities as the data is updated. As with other tools
having alert-generating capability, you can route orders directly to the Orders tool for
automated order entry via the Auto Place function. You may also Stage Orders for later
submission, Place Orders for immediate submission, or send the alerts to be monitored in
the Quotes tool.
Strategies are executed only when a new complete bar interval is received.
Alerts and indicator calculations are based on the last complete bar interval
only.
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Automated Trading
When you select the Enable Automated Trading button in Wealth-Lab Pro, the Orders tool
will automatically place orders that are received from any tool that generates an Alert.
This is true hands-off trading; therefore use this option carefully.
Important! When the Auto Trading is enabled, it is enabled for all your Fidelity
accounts in a given household.
In general, the Orders tool ensures a consistent order flow from trading strategies such
that each trade remains open or canceled based on the trading strategy's logic and that
no order is duplicated.
Orders that are already staged will not be submitted upon selecting Auto
Trading Mode. Also, orders entered manually and put in the queue by clicking
the Stage Order button will not be placed automatically even if Auto Trading is
enabled.
Auto Trading will be turned off by any of the following actions:
· Clicking the Enable Auto Trading button after it has been selected
· Clicking the Cancel All Orders button
· Closing the Order Manager
To learn more or get started using Auto Trading, please call our Active
Trader Service team at 1-800-TRADER1.
Automated trading poses significant additional risks. Use of Wealth-Lab Pro’s automated
trading feature is subject to additional terms, conditions, and eligibility requirements.
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